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WEMo 3.1 Overview

The Wave Exposure Model 3.1 (WEMo 3.1) was designed to bridge the gap between
ecologists and managers on one hand, and physical hydrologists on the other. Generally, the
physical context is poorly represented in ecological field studies largely because there are
few simple-to-use, inexpensive, parsimonious tools to provide objective information that do
not require extensive advanced physical models. Wind waves, particularly those associated
with storm events, are unpredictable and sometimes pose dangerous situations under which to
collect empirical information, whereas in contrast tidal currents are more readily addressed
because of their predictable and systematic nature. Therefore, we have attempted to create a
process that allows the uninitiated ecologist, biologist, resource manager, etc., to add a tool to
their analytical toolbox that accurately represents the effect of exposure to wind waves for
their particular study situation.

The most essential part of running WEMo is assembling the input data. Therefore, the user
must make some judgments as to what kind of data are appropriate to use. Finer resolution
datasets (spatially as well as temporally) potentially increase the precision of the output but
also dramatically increase the processing time.

WEMo was modified in this version (WEMo 3.1) to calculate wave height and derived wave
energy called Representative Wave Energy (RWE) along with the relative index calculated in
older WEMo versions (called Relative Exposure Index; REI). Selection of the mode depends
on the project requirement, geographical area for the study and time scale used in the study.
Each mode is discussed separately.

RWE Mode

Coastal managers are often required to estimate wave energy in coastal regions or in inland
waters from local wind information. This entails the computation of wave propagation in
coastal regions with shallow waters taking into account the effects of wind and local
bathymetry. WEMo is modified to essentially carry out such computations as a numerical
one-dimensional model. Representative wave energy (RWE) computed by WEMo is based
on linear wave theory and ray tracing technique. It represents the total wave energy in one
wavelength per unit wave crest width. RWE units are J/m or kg/m/s®. (USACOE, Shore
Protection Manual, Vol. 1)

WEMo computes the wave height for RWE in a monochromatic approach, i.e. along
each ray generated by the winds in same direction. Waves generated are propagated along
the fetch rays. Propagation of water waves over irregular bottom bathymetry involves
processes like shoaling, refraction, diffraction and energy dissipation. In order to
decrease complexity and computation time, refraction and diffraction of the waves are
neglected and propagation is carried out by shoaling, wind generation and dissipation
over downwind distance over water (fetch). The final output is the combined effect of
wind generation, shoaling and dissipation due to wave breaking and a fetch-weighting
process to account for shoreline irregularities. Fetch is defined as the distance from the site
to land along a given compass heading. Fetch value can be adjusted in WEMo, 10km is the
default value. Effective fetch was computed by measuring along a user-selected set of rays
radiating out from either side of the i"" compass heading at equal degree increments (total
number of rays ranges between 16 and 56, depending on the judgment of the User in the need



to capture shoreline shape; uncomplicated, linear shorelines can probably be accurately
assessed using the lowest number of rays while highly crenulated shorelines with
complicated intervening bathymetry should use the maximum number of rays). Effective
fetch is then calculated by summing the product of fetch x cosine of the angle of departure
from the i heading over each of n number of lines and dividing by the sum of the cosine of
all angles. This weighting of multiple fetch measures for each ray heading helps account for
irregularities in shoreline geometry that could misrepresent the potential of wind wave
development from a given direction.

REI Mode

REI mode does not compute wave energy. In contrast, an internally consistent relative index
value calculated for a site provides a context for evaluating how exposed a site is to wind-
generated waves in comparison to any other site. The higher the REI value at a site implies
higher wave energy will be experienced at that site, hence REI values are used for comparing
among two sites under seemingly like conditions. For those working in fairly uncomplicated
geomorphologic settings and needing only a quick approximation, REI mode will give values
that behave quite similar to RWE, but at a fraction of the computational cost.

To compute the REI using WEMo, each of the major eight compass headings, wind speed,
frequency of wind from that direction and fetch are combined to produce a relative exposure
index. Fetch is defined as the distance from the site to land along a given compass heading.
Fetch longer than 10km were clipped at 10 km as this was considered to be a sufficient
distance to generate a maximum wave height effect following empirical experimentation with
the USACOE Automated Coastal Engineering System software (version 1.07). Although the
fetch may be adjusted in WEMo, 10km is recommended. Effective fetch was computed by
measuring along 4 lines radiating out from either side of the i compass heading at
increments of 11.25 degrees, including the i heading. Effective fetch is then calculated by
summing the product of fetch x cosine of the angle of departure from the i heading over
each of nine lines and dividing by the sum of the cosine of all angles. This weighting of
multiple fetch measures for each compass heading helps account for irregularities in
shoreline geometry that could misrepresent the potential of wind wave development from a
given compass heading.

A Note About Tides

The reader will see that throughout the manual there are references to downloading
bathymetry data from various sources. It is critical that the user understand the tidal
reference of the data they are using; most of the sources we use in this program are set to
Mean Lower Low Water (MLLW). Thus, if one wanted to assess exposure of a site to waves
at high tide — especially when there is significant tidal amplitude, the user would have to
manually adjust the entire bathymetry data set to account for their desired stage of the tide.
As a result, the user may want to consider several runs of WEMo at different tide stages in
order to account for the influence of shoals as they become submerged (and less effective at
diminishing waves) with increased tide. Similar considerations should be taken for storm or
El Nino effects where systematic changes in tidal elevation are anticipated.



System Requirements
The following are the hardware requirements of WEMo 3:
e 1 GHz CPU (Recommend 1.5GHz or above)
¢ 512 MB memory (Recommend 1 GB or above)
e 500 MB minimum free space of hard disk is need to install and run the program.
The following are the software requirements of WEMo 3:
In order to install and use WEMOo 3, you must have the following:

o Microsoft Windows 98/ME/XP/2000. It is recommended that you have latest service
pack for each operating system

e ArcGIS 9.1 or higher version from ESRI (optimal license is ArcGIS 9.2)
Note: ArcInfo or ArcEditor license is required for some steps described in creating
shoreline input dataset (pg. 42).

WEMo Installation

WEMo should install easily. Make sure ArcGIS 9.1 or higher version is installed on the PC
where you are installing WEMo. If you have an ArcView network installation, then you’ll
need to install the WEMOo on the ArcView network server.

Confirm that you have administrative privileges. If you do not you will have to contact your
system administrator to install WEMo.

Download the WEMo installation file in zipped format from the website
(http://www.ccfhr.noaa.gov/stressors/extremeevents/wemo.html). After unzipping double
CLICK on file WEMo.msi. Follow the instructions provided by the setup program to install
the WEMo. WEMo will be installed in a directory, which you have selected and that will
become the application path.

Files Installed
Following important files are installed by WEMo installation in program folder.

WEMo.exe C:\Program Files\WEMo03.1
WEMo_V3.pdf C:\Program Files\WEMOo03.1\Help
WEMo 3_install.doc C:\Program Files\WEMo03.1\Help


http://www.ccfhr.noaa.gov/stressors/extremeevents/wemo.html

Project Composition

WEMo organizes data into projects. Project files contain the bathymetry grid, shoreline
coverage, processed wind data file and zero or more point datasets. Project file structure is
defined in the diagram below.

Project Structure

Input Input Input Input/create

1. Output 1 Output 1 Output

Density Plot Point shapefile Table

WEMo 3 projects have a unique extension of *.wpro_RWE or *.wpro_REI based on the
running mode of WEMo. It is an ASCII format file storing the information about various
datasets.

Project files may have one and only one shoreline coverage, bathymetry grid and processed
wind data file but any number of point datasets associated with them. These are the four
required datasets needed for running the model. Project files may be stored anywhere and can
have any name recognized by Microsoft Windows. They can also be created and deleted
using WEMo 3.



Getting Started

Interface description.
Disclaimer:

By using this software tool, you indicate your awareness of and consent to
the following terms and conditions of use:

Information provided from this software tool is NOT intended to be used for decisions
involving human safety and welfare risks. The developers of this program—the
National Oceanic and Atmospheric Administration—assume no responsibility and can
not be held liable for any end use of this software. For your own protection, please
label all output with "NOT FOR USE INVOLVING HUMAN SAFETY AND
WELFARE."

Digclaimer

By uszing thiz software tool, you indicate your
awarenezs of and conzent to the following terms and
conditions of use:

|nformation provided from this software tool iz HOT intended to
be uzed for decisions invalving human safety and welfare risks.
The developerz of thiz programithe Mational Oceanic and
Atrozphenc Administrationlazsume no rezponsibility and can not
be held liable for any end use of this software, For pour own
pratection, pleaze label all autput with

"MOT FOR USE INVOLYING HUMAN SAFETY AND
WELFARE."

) | Accept ) | Decline Ok

4 pplied Spatial Ecology Habitat Charactenization, MOA% Beaufort Lab

O 2 m3

=
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Menubar Toolbar
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Project Window

Data Window

[~ Bathymetry on top

Display Window

Toolbar description

DY Create a new project.

= Open an existing project

H save project

x Remove project

& Change bathymetry for a project fi

le

= Change shoreline coverage for a project file

I Change wind data for a project file
2 Create point dataset.

£3 Add external point dataset

Y Run

R Zoom in

10

WEMo Fast Mode status WEMo mode status
Status bar /
¥ = =
105059124 322 5A0G5 FasMlgorithm | FWE Mode




Q Zoom out

O} Zoom select
™ pan

® Full extent
@ |dentify

WEMo Mode

As mentioned previously, WEMo 3 can run in two modes, Representative Wave Energy
(RWE) mode and Relative Exposure Index (REI) mode. WEMOo’s Representative Wave
Energy or RWE mode carries out computations as a numerical one-dimensional model.
RWE values computed by WEMo are based on linear wave theory and ray tracing
technique making it a model of Lagrangian nature in a sense that the wave generation and
dissipation is considered while traveling with the waves along rays. RWE represents the
total wave energy in one wave length per unit wave crest width. RWE units are J/m or
kg/m/s? (USCOE 1977).

REI mode is a non-physical relative mode to assess the amount of energy reaching a
location. REI values are compared spatially or temporally to provide a context for
evaluating how exposed a site is to wind-generated waves in comparison to any other site.
REI approaches a unit-less dimensionless quantity in flat, non-varying landscapes; as
such we do not ascribe any units to WEMo. The higher the REI value at a site implies
higher wave energy will be experienced at that site. REI is a very parsimonious factor in
simple landscapes and has the benefit of faster calculation.

WEMo mode can be selected based on the project requirement and data analysis method
chosen. WEMo mode can be accessed from menu bar Data > WEMo Mode. WEMo
always starts in RWE mode and should be changed every time application is started to
access REI mode.

¥ WEMo Mode mE x|

Select WEMo Mode

(* Reprezentative Wave Energy [ndex [RWE | Mode

(" Relative Expozure Index [REI Mode

Settings
Settings for WEMo can be accessed from menu bar Data > Change Settings. Settings should

be checked after installation of WEMo and before running each session. Settings options are
different depending on the WEMo mode.
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RWE Mode
The window’s first tab ‘General’:

Select the path for storing WEMo project; default path is the application path.

Type the name of WEMo project file, default is “WEMo_Proj”.

Choose the number of rays created for each site.

Check to use faster clipping algorithm. Checking this option means that the
bathymetry grid used for processing should reach zero water depth as near to the
shoreline as possible or the bathymetry grid should be clipped with accurate
shoreline vectors to set the location of the shoreline in the bathymetry grid itself
(also, see “A Note About Tides” section, above). Creating the Clipped grid requires
ESRI ArcMap and Spatial Analyst extension. Unchecking this option makes
WEMo 3 run slower and can only process 500 points or less at a time. Points can
be divided into smaller group and processed separately.

5. Check box ‘Remove refresh capability and run WEMo in background’ to allow
WEMo running in the background without the graphic display and interference.
This option makes WEMOo run faster.

# Settings M =]

T Parameters

N

Select directam for project

[
CAWEMo_werd
Y Project
(L] output_dats

|Qc: LJ

Type narme for project file

WwWERMo_proj

Select the number of raps to be created for each site?

16 (+ 32 " an " ag " BB

Uze faster algorithm for clipping rays.

[Mate: Checking thiz option requires that you input bathymetry grid accurate
Iv enough or arid should be clipped to the vectar shoreling which requires

Archiap and Spatial Analpst extension. Mot checking this option make WEMao

un slower and can only process at most 500 sites at a time. |

I Remove refresh capability and run WEMo in background.

I Set default zettings

oK | Cancel |

Setting window’s second tab “Parameters” set physical constants to run the model.
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1. Select the maximum fetch limit in meters. Fetch is defined as the distance from the
site to the first encountered land along a given compass heading. The default fetch
set in WEMo is 10,000 m, a value based on an empirical assessment of the distance
to fully develop a wave using linear wave theory (Automated Coastal Engineering
System, US Army Corps of Engineers v1.07).

2. The Fetch Length Segment selection defines how far out from the point of interest
that WEMo uses the maximum resolution of the bathymetry grid to conduct
interrogations of the effect of water depth (i.e., if your bathymetry data set had 6 m
resolution between depth measurements, WEMo would assess the effect of
bathymetry every 6 m). The default value is set at 1000 m. Make sure this value is
smaller than maximum fetch selected.

3. Beyond the distance selected in (2), WEMo will use the value set in the
Bathymetry Interrogation Distance Box for the spacing interval at which
bathymetry is interrogated; the default spacing is 100 m. We give the option of
making the spacing coarser beyond the Fetch Length Segment to save on
computing resources as the influence in bathymetric changes at these distances
from the point of interest have comparatively little effect on the overall
computations of exposure. We do not recommend ever attempting to use a
resolution (spacing) finer than that of the bathymetry grid itself.

4. The next three parameters are set for determining wave breaking constants and
should only be changed after careful analysis.

Alpha in Goda’s formula is a constant set at 0.17 default value.

Sensitivity eps is used to get estimation accuracy in calculating model values.
Default value is set at 1 in 1000.

Beach slope is set at 1.909 degrees equivalent to 1/30; this is a very shallow
slope; note that the angle of repose of most sand is closer to 1/3 which would
be more appropriate for channel margins.

To set the default values check ‘Set default settings’ and all values returned to the
default.

13



K Settings =JIOEd

General T Parameters

Tuvpe Fetch in meters
F {10000 m [Example 10000, no cormma)

Distribution of Fetch

Fetch segment Lenath after which highest [1000 m
bathymetmy rezolution is uzed:

Bathymetry Interrogation Distance

Fetch segment Internogation Distance before 100 m
highest bathymetm resolution iz used:

Wave Breaking Parameters

Alpha Goda's Formula: 017 m
Sensitivity eps: 1in [1000
Beach slope for Goda's Farmula: 1.909 Degres

I Set default settings

ak. Cancel

REI Mode

The settings window has the main setting options on the tab *‘General’:

1. Select the maximum fetch limit in meters. Fetch is defined as the distance from
the site to the first encountered land along a given compass heading. Default fetch
set in WEMo is 10,000 m, a value based on an empirical assessment of the
distance to fully develop a wave using linear wave theory (Automated Coastal
Engineering System, US Army Corps of Engineers v1.07).

2. Select the name of WEMo project files default is “WEMo_Proj”. Any name
could be chosen, recognizable by Microsoft Windows.

3. Select the ‘Distance for bathymetry interrogation’ in meters. This is the spacing
between interrogations of water depth for use in the weighting of the fetch
measurement. The distance for bathymetry interrogation is usually chosen equal
to the bathymetry grid spacing. Default distance set in WEMo is 100 m.

14



Settings E]

General T Power Function

Type Fetch in meters Select directory for project

F lyoooo  mis 300

ERWEMo_ver3
5 Praject

[ output_data

[Example 10000, no comma

Type name far project file

|WEM|:|_|:|r|:|i

Digtance for bathymetry interagation

=¥ j

Bl [1o0 - | mte

|Jze faster algorithm for clipping rays.

[Mote: Checking thiz option requires that pou input bathermetry gnd accurate
Iv enough or grid should be clipped to the vector shoreling which requires

Arctap and Spatial Analyst extenzion. Mot checking thiz option make

YWEMD run glower and can only process at most 500 sites at a time. |

v Remove refresh capability and run ERMo in background.

[ Set default zettings

k. Cancel

o &

~

Select the path for storing WEMo project; default path is the application path.
Check box “Use faster algorithm for clipping rays’ to make WEMo run in a faster
mode and if you want to run multiple wind datasets on the same geographic
locations.

Check box ‘Remove refresh capability and run WEMo in background’ to allow
WEMo running in the background without the graphic display. This options
make WEMOo run faster.

IDW power function settings are done on ‘Power Function’ tab.

An Option is given to select the range of powers for the IDW function or you
may use your own with your own defined wind speed categories (see Appendix A
for explanation of these power functions). The default ranges were empirically
derived after examination of the wave decay/growth functions in the Shore
Protection Manual.
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9. Selection of up to five speed categories can be done and corresponding powers
are entered as numerical values. Wind speed should be entered here in miles per
hour (this is because most data are reported in these units; however, these values
are transparently converted to m s automatically during the computation

process).

K Settings

=JOkS

General

T Power Function

Do you want bo uze recommended
poweers for [DW functions?

* Yes " Mo

Recammended power Far the [0 funchion
“Wind Speed range Fawer
0--30mph or 0--13.41mds 0053
A0+ - B0mph or 1341+ - 2682 m/= 0062
»=B0+ mph or »= 26.82m/s 0.0s2

Check Appendix & in help file
for more details.

[ Set default zettings

0k

Cancel

Power for IDW function represents the effect of fetch on the site. The higher the power value,
the lower the effect of fetch on the REI values. Lower power represents more of an effect of
distance. For more details check Appendix A.
Clicking OK will change the settings and they will remain same even after you close the
application, so you don’t have to change them every time. Checking the ‘Default’ button
changes the current settings to default.
Note — Settings should always be checked after loading or creating a Project to ensure that
inappropriate settings from previous sessions have not been used.
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Batch Processing Mode

A new batch processing mode is added in WEMo 3.1 version. This mode allows WEMo to
run with a set of wind data files instead of just one at a time. This addition saves considerable
time and effort in running the model with different wind data scenarios.

To put WEMo into batch processing mode, ‘Batch Processing Mode’ check box should be
checked. Check box can be accessed from the main menu.

% Batch Mode

B atch Proceszing Mode

[ iCheck for batch processing mode

k. Cancel |

Once project files are loaded and point dataset is selected (explained in detail in the next
section) WEMo provides the option of selecting the folder where wind data set files are
stored.

¥ Batch Processing
Pleaze zelect the directary where proceszsed wind filez are located
=« &l
[ [ rplv2_2006_03_23_30_21_03%ind_|a
S WEMo_verd ArcGIS92 rplvE_ 2006 03 2930 22 04wind |
=9 Project rphvd_ 2006 03 2930 23 05'wind_
""" Ny Bateh Process wind, Diata P |[rphve_2006_03 3030 00_06.w/ind_

rplv@_ 200603 30_30 01_07\wind_
rplv@_2006_03_30_30 02 02:ind_
rplvd_ 200603 30_30 03 09:ind_
rplv2_ 200603 30_30 04 105wWind_
rplv2_2006_03_30_30 05 171.wind
rplv2_ 2006 03_30 30 06_12'wind ||

184 wind filez in the folder

I Check for using Tidal corrected depth data

Select the ASCH file containing the tidal corected depth data

Ok Cancel ‘
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Generally wind data set folder defaults to ‘Batch_Process_Wind_Data’ in ‘Project’ folder
under WEMo application folder. Label below the data set window shows the number of files
in the folder.

All the output data from WEMo (RWE, wave Height and wave direction) are written in a text
file “batch.txt’ located in “output_data’ folder in WEMo folder and is rewritten every time
WEMo runs in batch process. Also all the output data is written in sequential order in the
batch.txt file.

Another functionality build in the new version of WEMo is the option to correct for tidal
fluctuations at a particular site. Tidal fluctuations at a site change the wave heights calculated
by the model since the water column height changes with the tides. In some geographic
locations tidal fluctuations are of significant magnitude and can cause considerable changes
in calculated wave energy and wave height values.

To include the tidal corrections in the model calculations, check box *Check for using Tidal
corrected depth data’ should be checked. This functionality requires the input of tidal data in
ASCII or text file format. One tidal height for each wind data file entered previously is
accepted. So, if finer temporal resolution is required on tidal corrections, finer temporal
resolution wind data files should be processed.

Format for tidal data should be as shown for example below:

ID  Tidal correction

1 2.3
2 2.8
3 2.9

Where total number of records should be equal to number of wind data file provided for
processing.

Note: This functionality is only available for single data point right now in this version of
WEMo. In future it will be included for multiple points.

Creating a Project file

After installing WEMo, CLICK on the icon WEMo or select it from the start menu. The
first screen asks you to make a selection of either new project file or opening an existing

project.
#* Welcome

D (+ Create a nes project

ar

=53]  Open an existing project

Ok Cancel

18



CLICK OK after making your selection.

Selecting option ‘Create a new project’ opens a new window to select the datasets for a new
project. The name and location of project file will be as entered in the settings window. If
there are project files with that name already in the folder an extension number is
automatically attached to it after the project name, for example, WEMo_projl.wpro_RWE or
WEMo_projl.wpro_REI depending on the mode. Check ‘Data requirements’ section for
selecting appropriate data for a project file.

#* New Project
Add Data

B athymetry D ata

| Erowse...

heter -
I Bathumetry Poszitive
Shareline Data
(* Arc Shapefile " Arclnfo Coverage
| Browse. ..
“Wind Data
{» TextFile
Add Wind Data Testfile
| Browse. ..
Ok Cancel

Bathymetry grid - CLICK on the Browse button in ‘Add bathymetry grid’ section to
select a bathymetry data layer. The appropriate grid is selected from the file browser. If
you can’t see your folder or directory, you have to add it using the Connection button.
To see the appropriate format of a grid accepted by WEMo check ‘Data requirement
section’. After selecting bathymetry please select the appropriate units that were used in
this data for the depth (m, ft or cm). Check the box ‘Bathymetry Positive’ if depth in the
grid is represented by positive numbers instead of negative (i.e., if the depth is measured
from the seafloor as opposed to from the water surface).

When the faster algorithm option is checked in the settings windows the bathymetry grid
should reach zero water depth as near to the shoreline as possible or the bathymetry grid
should be clipped with accurate shoreline vectors to set the location of the shoreline in the
bathymetry grid itself (also, see “A Note About Tides” section, above).
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Connection hutton

/
Select a Bathymetry Coverage /

Lok it: ||:| grids_shorelines

Marme | Thpe [
[ alaska Folder
[ chesapeakebay Folder
(I flaridakeys Folder
(dMcBayl Folder
(dSarasota Folder
[(dsf Folder
[(tampa Folder
[ tampabay Falder
(1 TampaBay_albers Folder ]
A TarmnaRavl TR Frldmr sl
M arme: | &dd

Show of type: |Fiaster datasets ﬂ m

Shoreline coverage - CLICK on ‘Browse’ button in ‘Add shoreline coverage’ section in
‘New project’ window to select a shoreline. The appropriate grids are selected from the file
browser. If you can’t see your folder or directory, you have to add it using the *‘Connection’
button. Either shapefile or Arc coverage formats are allowed.

Both shoreline coverage and bathymetry grid must be projected in same projected
coordinate system like UTM or state planes and not in Geographic coordinate system.

Wind data — For REI mode there are two options for selecting wind data for a project, either
you can create a new wind data file or you can attach a previously created wind data file by
CLICKIing the appropriate option button. If you CLICK the “Text file’ option, you have to
select an already created Wind data using the ‘Browse’ button in “Wind data’ section. Once
selected the REI wind file will have extension *.Wind_REI. This file is a product of the
‘Analyze Wind Data’ option in the Wind menu. The default folder is the application path. If
your selection is ‘manual’ a new form opens where you can enter the wind data; i.e. wind
speed and wind frequency for eight compass heading directions, station name from where
data was collected and start and end time for the data analyzed. After entering the data you
could save the wind data file for future purposes. If data are not saved in a text file, ‘memory’
will be written in front of the wind data in the Project window and the data will NOT be
saved when the session ends.
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¥ Enter Wind Data

Select Unit for wind speed mis
tean E asterly 'Wind Speed ||7 ms
Fercent E azterly Wind Frequency Ii %
tean South E asterly 'Wind Speed Ii my'z

Perzent 5outh E azterly YWind Frequency %
tean Southerly *ind Speed 'z
Percent Sautherly YWwind Frequency %

Mean South Westerly “Wind Speed mi's

Percent South Westerly *Wind Frequency i

bean Westerly Wind 5 peed my's
Percent Westerly \Wind Freguency i
tean Harth \Westerly *Wind Speed s

Percent Morth ‘Westerly *ind Frequency Ii A
Mean Mortherly \Wind Speed Ii mes
Percent Mortherly 'wind Frequency |7 %
Mean Marth Easterly 'ind Speed Ii mes

Percent Marth E azterly Wind Frequency 4

Infarmaticrn
Station name |
Start Date | dd Ay bk mm
End Date | mm/dd Ay bk mm

k. Cancel

For RWE mode all data are created using ‘Analyze Wind Data...” command accessed from
Wind menu. Wind files are directly downloaded from National Data Buoy Center (NDBC)
website for select stations from the list. Select the start year, month, day, and hour to
choose the starting time for analyzing wind data. You have the option of selecting time to
the nearest hour as temporal resolution. Similarly, select the ending year, month, day and
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hour. Select the top percentage of wind speed for analysis using the slider bar. WEMo
uses normal frequency distribution to select the top 5% of wind speed events (after
Keddy 1982). Selecting a low, top percentage wind speed will result in only high wind
speed events being selected for analysis. After choosing all the parameters, CLICK
‘Analyze Wind Data’. Big performance was achieved for WEMo 3.1 for processing
wind data where it can cut time four folds in processing big datasets compared to
WEMo 3.0.

Note - Before selecting start and end time, please navigate to the station website,
provided in the links above, to check whether data for that time exists or not. If you select
year for which there is no data on the NDBC website, you might get an error message or
that data year will not be included in your analysis.

o -1

¥ Wind Analysis

For analyzing wind data text file on your local diive, click here |

Wweb download

Select Station to downlaod data from MDEBEC website

clkn?, Cape Lookout MC j
Start Year [|ncluded) Maonth [ray Hour
195 = 1 = =] o -
End “r'ear [Included) tonth [ray Hour

20z~ 12 ] |31 = |- |

Chooge the top percentage of wind speed for analysziz

|
J 5

e

Mate: All wind data are collected from MDEBC, MOAS website
vy ndbe noaa.gov. So pleaze make sure whether data are
available for the station for the particular years befare running the
analyziz. Link iz provided in ind menu.

Analyze Wind Data Cancel
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In case no station is found in the downloadable NDBC list for your area, WEMo can process
text files containing wind data in certain format. Text file could be space, tab or Comma
delimited and should be in NDBC wind data file format.

NDBC file format is described below:

All fields are divided into individual columns separated by delimiters.

Wind speed is in meter per second.

Wind direction is the direction the wind is coming from in degrees in clockwise from
true north.

e Data should be at least every hour and can be up to Iminute temporal resolution.
Example of NDBC format:

YY MM DD hh WD WSPD GST

95 01 01 00154 9.2 10.1

Other formats of wind text files should be manipulated in MS Excel or other software to
match NDBC format before processing.

Import of the wind data from the text file should always start importing from the row where
headers are located. Unwanted data entries should be clipped before importing either by
selective highlighting or simple trimming and saving before importing.

=Joed

* Wind Analysis

Chooze the delimiter

(* Space i~ Tab " Comma

Start import of data at row: |4 -

Browsze for ASCI wind file

browse. ..

Select variouz fields

Y'ear konth [ray Howr hinute
| =l | =l | =l | =l | =]
“wiind 5 peed “wfind Drirection
- -

QF. | Cancel |
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After selecting all the parameters CLICK OK and WEMo will ask you to type in the station
name for metadata purposes along with start and end dates and top percentage of wind speed,
similar to REI mode.

-

¥ Wind Analysis x|

For analyzing wind data test file on pour local drive, click here |

wieb download

Twpe Station name for metadata

|Eape Lookout

Start Year [Included) orth Day Haur
M35« |1 | 1 | jm ]
End vear [[ncluded)] kd anth [ray Haur

2002 w12 | 31 ~| |23 |

Choose the top percentage of wind speed for analysis

il

|
J 5

Mate: &ll wind data are collected from MDEC, MOAS website

v ndbc.noaa.gov. So pleaze make sure whether data are
available for the station for the particular years befare running the
analpziz. Link iz provided inWind memn.

Analyze Wind Data Cancel

Note - Use only numeric values otherwise an error message will be generated.

Note - Always save wind data associated with a current project otherwise the wrong wind
data may be used for processing (i.e. data from a previous session). Whenever you
see a temporary file with project wind data in the project window, create a different
project or add a new wind data file.

Note — When manually entering wind speed, you may select different units; the program
checks your selection and transparently converts it to m s™.
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Opening a project file

CLICKIing the ‘Open existing project’ option and the ‘OK’ button opens a window to
select the project from the folder. The Default folder is the application path. So - select the
appropriate project and CLICK *OK”.

After selecting the project or creating a new project, both windows (i.e. Project window and
Display window) get populated. The Project window contains all the datasets associated with
the current project. The name of current project is displayed as a root and all datasets are
displayed as its children. The Dataset window shows all the geographic datasets associated
with the project and are shown in the Display window.

Note: If you try to open a previous project with the wind data stored in the memory option
you will get an error message. Projects with wind data in memory mode can’t be saved and
hence can only be used for a quick one-time use — which may be useful during exploratory
phases.

.
K WEMo
Project Data  ‘Wind Display  Help

DEEeX &>4 a8 0 QRO 0

T .Fi'ro.iec:t";\:\-"ln;:lm-@ 1 Diéplay Window -

=l Erq' WEMo_prol FWE" : |
% tampa_utm ) %
= Tampa_shore_ %‘
m port_manatee_ ?

< ||

; = v
v Bathymetry on top <] i (]

| 30011551338 3116217.45416 Fast Algonthr RWE Mods

The Project window contains names of all the datasets associated with the current project.
The first entry shows the current project name. Further entries in order will be the bathymetry
grid, shoreline coverage, wind data file and point datasets associated with the current project.
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Adding point datasets
Point datasets may be added in three ways for a current project.

Note: Point datasets may only be added after you have a current project.
Note: All points selected for sites MUST lie OVER the shoreline and bathymetry datasets,
otherwise WEMo will fail.

1. Using create point dataset method. 2

CLICKIing this button puts WEMo in editing mode. After CLICKing ‘yes’ for
creating a point dataset, left CLICK to create new points for desired sites. You can
create unlimited points (< 500) using this technique. Panning and zooming is possible
in the middle of point creation. When you are done with the point creation,
CLICKIing the "build’ button on the upper right corner of the Display window adds a
new point dataset in both the windows and you can view your points in Display
window. If you don’t want that dataset, CLICK cancel. The point dataset name will
be ‘pointdata’. Any number of point datasets can be attached to a project and their
name goes with a number extension. Datasets created by this method are permanently
associated with the current project. The only way to remove these datasets is by
manually going into ArcCatalog and deleting them. The point dataset created is in a
Microsoft Access format.

2. Using external point dataset method. 3

CLICKIing this button in the toolbar allows you to add point datasets. Point datasets
should be in ArcView shapefile format and consequently should be a point shapefile.
The selected shapefile is displayed only in the Display windows but not in the Project
window, because this external shapefile doesn’t get associated with the current
project. However, you may still run WEMo on the shapefile points. This means if
you open the project next time, however, that shapefile won’t be displayed in any of
the windows. To create a regular point grid for a larger area please check the
Appendix C at the end of the manual.

Note: If you add a shapefile with a name starting with ‘pointdata’ it will be displayed
as ‘shppointdata’, to keep it different from other, previously created datasets.

3. Upcoming addition Using text point dataset method. (Inactive at this time)
Point datasets may be created by entering x and y coordinates manually. This could
be accessed through Data - Enter point data in Menubar. A new window ‘Enter
point data’ opens. After the window opens, enter the number of points you have to
create. There are two options to select the coordinate system of the point coordinates.

Geographic coordinates: You can enter point coordinates in the geographic
coordinates window in latitude and longitude as
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A% Enter point data

&

Haw many painks you want ta enter? |1
Select the coordinate spstern of the ||ata"|Dng ﬂ
point coordinates
Select the datum for point coordinates | j
Langitude Latitude
|-89.46 |23.56
Entering paint 0 riesst | |

decimal degrees. You can also select the datum for your point coordinates from three
choices of NAD1983, NAD 1927 and WGS 1984. The points are then converted into
the current project datasets coordinate system, which could be either a geographic or
a projected coordinate system. The point could also be entered by CLICKing the
‘next’ button. You could go back to previous points and make changes by
CLICKIing the “previous’ button. CLICKing on the “final’ button (*‘next’ changes
to “final’ after entry of the last of the points) creates the new dataset or you could
CLICK “cancel’ to end without creating points. The point dataset created is in a
Microsoft Access format.

UTM coordinates: However, you may also enter point coordinates in the UTM
coordinate system. Select the zone of UTM for your point coordinates (if you need
reference for selecting UTM please check the website referred in the ‘Finding data’
section). You also have to select the datum for the UTM coordinates.

3

A% Enter point data

How many pointz you want to enter? |3

Entening point 0

Select the coordinate spstem of the [ JTh - 18
point coordinates | J | J
Select the datum for point coordinates |N.¢‘-.D 1933 ﬂ
=, '
I [
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The newly created point dataset is added to all three of the WEMo windows unlike the
externally added dataset. The default name assigned to the dataset would be ‘pointdata_ext’.
If there is already a point dataset with this name an extension is added at the end of dataset
name e.g. ‘pointdata_extl’. The point dataset created is in a Microsoft Access format.

Note: This functionality is not fully functional yet.

Running WEMo %

After creating a project and entering a shoreline, bathymetry dataset and finally, entering the

point dataset, you can run WEMo by CLICKing the 'Y button. The window opens asking
for you to select the point dataset from the list of points in the Dataset window.

=,

% Select Point Dataset

Select Point Data

Select point feature dataset o run model
| [

n Cutput fetch length [Rapl az Horth rap with increasing number in
clockwize direction].

2k, Cancel

CLICK the option to select the fetch length being outputted in the shapefile. WEMo will
output fetch length for all 32 rays, starting with ray 1 in north direction and increasing in
clockwise direction as shown in image below.
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After selecting a point dataset and CLICKing the OK button, WEMo runs for each point in
the selected dataset successively. In the point dataset, a new field is created named ‘RWE’ or
‘REI’ depending on the WEMo mode. Index values could be viewed using the Identify tool
in the toolbar for each point, or opening the dataset attribute table in either ArcMap or
ArcCatalog. Attribute tables could be exported to MS Excel file or dbase or could be
exported as a shapefile from the geodatabase. If an external shapefile is selected for running
WEMo, a new field is created in that shapefile with calculated REI values.

Note: Running WEMo is a CPU intensive task, it consumes CPU time. Also once you
CLICK the ‘run’ button to start processing; you can’t stop processing unless you use
Windows Task Manager to shut it down. So carefully select all the parameters before
running WEMo.

Output files (RWE)

Many other additional files are created by WEMo in RWE mode, mostly used for
debugging or later use on detailed analysis. Output files have data only for individual
points and are rewritten every time a point is processed; hence it only contains data for
last point processed.

All these files are saved in the application folder under Project\output_data. A list of
these files is mentioned below.

Windarray.txt = Wind speed and frequency for individual rays.

Fetcharray.txt = Fetch distance (meters) for each ray.

Wave HT_first\waveHt_first i.txt = wave height observed for the first fetch segment for
the i" ray at the site. Wave heights recorded at every few meters specified in WEMo
settings.

Wave_depth_first\depth_first i .txt = average depth observed under the first fetch
segment for the i" ray at the site. Depth recorded at every few meters specified in WEMo
settings.

Wave HT_second\waveHt_second i.txt = wave height observed for the rest of fetch
segment for the i ray at the site. Wave heights recorded at every few meters equal to the
resolution of bathymetry grid.

Wave_depth_first\depth_second i .txt = average depth observed under rest of the fetch
segment for the i ray at the site. Depth recorded at every few meters equal to the
resolution of bathymetry grid.

WaveHt.txt = Final wave height in meters for individual rays for the last point processed.

RWE.txt = Final RWE values for each of the rays for the last point processed.
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Additional Functionality

Projection properties

The current project projection properties can be checked using this utility. This utility may be
accessed through Data - Projection Properties or by right CLICKing either bathymetry
dataset or shoreline dataset in the Project Window.

A Projection Properties @

Gengraphic coordinate spstem
GCS_Morth_American_13983

Removing projects

Projects currently loaded may be removed using the X tool or using menu Project—>
Remove project. This could also be accessed using the right CLICK on ‘Project name’ in
the Project window.

Deleting projects

Projects may be permanently deleted using the Project > Delete project. CLICKing this
menu button shows the file selection window. After selecting the project, CLICK OK, as
this deletes the selected project and all attached internal files (not datasets).

Save projects

Current projects may be saved by CLICKing Project - Save project. To change the project
name use ‘Save Project As’ button. New projects may be saved with different names by
using ‘Save project As’ button.

Change datasets
Current project datasets could be changed using menu buttons or toolbar tools.

To change shoreline data use Data - Change shoreline coverage or toolbar button =
To change bathymetry data use Data - Change bathymetry coverage or toolbar button &

To change wind data use Data - Change wind data or toolbar button i
Removing datasets

Datasets may be removed from the Display window and Data window by double CLICKing
in the Data window.
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Identify

Spatial features may be identified using the ® t00l. A window opens showing the attributes
of the feature. The dataset may be selected for the desired feature using the drop down menu.
The location of the feature is displayed in the right window.

Identify Results X

Layers: |<T|:||:|-m|:|st layer: ﬂ
—|- karmpa_clip Laocation: (343185 559018 3069354, 228552)
*+-3.19572 Property Walue
Stretched walue 156
Fiwel value -3.19572

Help
Help may be accessed using Help = contents. Help file is in adobe acrobat file format.

REI Mode Utilities

Analyze Wind Data

Wind data can be analyzed directly in WEMo. Wind data are downloaded directly from
National Data Buoy Center, NOAA website. National Data Buoy Center (NDBC), a part
of the National Weather Service (NWS) that develops, operates, and maintains a network
of buoy and C-MAN stations. NDBC provides hourly observations from a network of
about 70 buoys and 60 C-MAN stations all over the US coast. All stations measure wind
speed, direction, and gusts. You may analyze wind data using WEMo by CLICKing
menu ‘Wind’ - *Analyze wind data...” to open the window as shown below.
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2u

e Wind Analysis @

Select Station

* Analyze all wind data in one file

- | J hr fior | hrs
Start Year [Included) Month Day Hour
E=Ed Bl 1 > o«
End ear [Included) Month Day Hour

iz w12 Bl |31 | = |

Chooze the top percentage of wind speed for analpsis

' %
) B

Fote: All wind data are collected from MDBC, MOA%Y webzite
vy, ndbc.noaa.gov. So pleaze make sure whether data are
available for the ztation for the particular vears before running the
analyziz. Link iz provided in ‘Wind menu.

Analyze Wind D ata Cancel

Select the station closest to your site from the ‘Select Station’ option. Various stations
listed in the drop box are shown below.

Note - If you can’t find any station close to your site, please check NDBC website, if you
find any station close to you on the website, please type it in the station selection combo
box using the format describe below.

clkn7, Cape Lookout, NC

Where ‘clkn7’ is the NDBC code for the station and ‘Cape Lookout, NC’ is the station
name. Both can be obtained from the NDBC site.

Note: Make sure the correct format is followed and it’s spelled correctly.
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http://www.ndbc.noaa.gov/station_history.phtml?station=clkn7

Select the start year, month, day, and hour to choose the starting time for analyzing wind
data. You have the option of selecting time to the nearest hour as temporal resolution.
Similarly, select the ending year, month, day and hour. Select the top percentage of wind
speed for analysis using the slider bar. WEMo uses normal frequency distribution to
select the top 5% of wind speed events (after Keddy 1982). Selecting a low, top
percentage wind speed will result in only high wind speed events being selected for
analysis. After choosing all the parameters CLICK ‘Analyze Wind Data’. You can only
select a maximum of 7 years of data for analysis due to database and processing
restrictions.

Note - Before selecting start and end time, please navigate to the station website,
provided in the links above, to check whether data for that time exists or not. If you select
a year for which there are no data on the NDBC website, you may receive an error
message or that data year may not be included in your analysis (be sure to double-
check).

Wind Data
Wind data attributes can be checked by CLICKing menu Data->Wind Data or by right
CLICKIing the wind data filename in Project window.

?}:ﬁ Wind Data Q@@

Wind Freguency %, Wind Speed m/s

4.04% 7183

12.02%, 749 451%, 70N
Morth
10.46%, %—"W’est E ast 4.4%, 7.009
7.569
South
11.81%. 7199 14 % 7728

38.29%, 7 953

33



Data requirements
Three main datasets are required by WEMo.

Shoreline dataset

The shoreline dataset is required to clip the fetch rays with the land if ‘Faster Algorithm’ is
not checked. Shoreline datasets should be as detailed as possible depicting islands and proper
shorelines.

Requirements:
e Datasets should be either an ESRI shapefile or Arcinfo coverage format
topologically clean
e Shoreline datasets should be a polygon coverage covering the waterside
instead of land as shown in the figure below.

Line coverage of shoreline can be converted into a polygon using ArcToolbox. Line
coverages should be closed to make a closed polygon, which can be a tedious process. For
example, the image below shows the shoreline coverage for Tampa Bay with enclosing the
water body.
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Bathymetry dataset

A bathymetry dataset is required to obtain the depth data for REI calculations. Bathymetry
should cover all the area covered by the shoreline as well as all the sites. Selecting sites
where bathymetry is not available will crash WEMo.
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Requirements:

o Datasets should be either an ArcInfo grid format, image format or shapefile
format.

e Bathymetry should contain depth information in meters (negative or positive).
Bathymetry in units other than meters will make it difficult to compare with
other WEMo results from other users.

e Bathymetry grid spacing should be at least 100m if using a 1 ha grid size.
Mismatched grid spacing creates scale mismatches with unknown
consequences.

Wind data (REI mode)
Wind data are required to calculate the REI values for a point. Two wind data parameters are
required to run WEMo:
1. A specified percent of top hourly wind speed observation (m s™* or mph) over the
preceding years at the site from eight compass headings (default 5%),
2. The top wind (exceedance) occurrence frequency from the eight compass headings
(default 5%).
Wind data may be analyzed using the WEMo analysis tool or from outside using other
software.

The example below shows two charts for frequency of exceedence wind and exceedance
wind speed (here, top 5% of wind events by wind speed) by direction on a star chart. These
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charts were generated using SAS.

Frequency of exceedence winds (op 5%) by direction:

PERCENT of dirfrom

nn
11.00%

wu ee
15.27% 10.69%

ss
11.19%

Above: example of frequency of exceedence wind (top 5%) by direction.

Exeedence wind speed fop 5% of events in m/sec) by direction:

MEAN of windsp by dirfrom

nn
7.663

ww

ee
7.395 7.466

ss
7.837

Above:

Example of exceedence wind speed (top 5%) by direction in m s,
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Sample Dataset

Sample datasets are including in the WEMo installation CD and installed along with
WEMo software. These data sets have been cleaned and meet all of our previously
described accuracy requirements; they may be a useful training tool as the results will not
be compromised by data issues, thus allowing the user to separate training with the
software from database issues.

Datasets can be found in the *sample dataset’ folder in WEMo installation folder.

Shoreline: Datasets include shoreline shapefile “NC_shoreline_UTM.shp’ for coastal NC
area for Core and Bogue banks with UTM zone 18 NAD83 coordinate system.

Bathymetry: A bathymetry grid included is for the same area with 86 m spatial
resolution and UTM zone 18 NADS83 coordinate system.

Wind: Also included are the processed wind data files; one each for RWE and REI mode
‘wind_nc.Wind_RWE’ and ‘wind_nc.Wind_REI’. Wind data are from the NDBC station
CLKN7 at Cape Lookout, NC processed for year including 2001 to 2004 using the
exceedance (top 5%) wind speeds.

Finding & Building data

Shoreline datasets may be found at NOAA website or USGS websites. These sites have a
large collection of shoreline datasets for estuaries and bays.

Bathymetry may be created using NOAA NGDS bathymetry sounding available at following
website:
http://www.ngdc.noaa.gov/

Website for UTM zones:
http://www.dmap.co.uk/utmworld.htm

Wind data may be obtained from NOAA National data buoy center website:
http://www.ndbc.noaa.gov/

Another wind data website from NOAA is:
http://co-0ps.nos.noaa.gov/co-ops.html

If wind data are not available for your particular site, data from other, nearby sites could be
used for analysis if you are satisfied with its veracity.

Bathymetry

A bathymetry dataset is required to get the depth data for REI calculations. Bathymetry
should cover all the area covered by shoreline as well as all the sites. Selecting sites
where bathymetry is not available will crash WEMo or not return an REI value.
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Bathymetry may be created using NOAA NGDC bathymetry sounding CDs available
from NGDC website for a nominal charge. The website for obtaining the CDs is:

http://www.ngdc.noaa.gov/mga/fliers/01mgg05.html

The CD contains Coastal Relief Models, which are topographic-bathymetric relief models
that integrate land and seafloor elevations by assembling a gridded database that merges
the US Geological Survey 3-arc-second DEMs with a vast compilation of hydrographic
soundings collected by the National Ocean Service and various academic institutions.
Eight CD-ROMs are currently available covering the US East, Gulf, and West Coasts.

Steps for creating bathymetry from the Coastal Relief Model CDs

1. Install the CD obtained from NGDC by navigating to setup/Windows folder and
CLICKIing setup.exe. Follow on-screen instructions to install.

2. To extract a bathymetry data, you have to install the CD volume separately.

3. From the start menu navigate to Programs-> GEODAS-> Coastal Relief Model. This
will launch your browser.

Z} NGDC Coastal Relief Model ¥ol. 03 - Microsoft Internet Explorer =13 x|
File Edit “ew Favortes Tools Help ﬁ
¢=Eack - = - @ A ‘ Qsearch  [GFavorites SfiMedia (4 | E-S -
Address |@ E:STARTCRM.HTM j @G0 |Links »
G(‘JDS]@-I j‘ @psearchweb - @ 5earch Site | Eoit) | RageRank iy - | Fdoptions [ >
| ——_\( T | W | Fi
|
e
105 100 95 90 a5 80 75 70 65°
wol. 03 Grid Images | Design-a-Grid |
Kl | _>l_I
[& [ [ = ey computer A

4. CLICK on Design-a-Grid button in the webpage and save the grid by assigning
some appropriate name in a designated folder.

5. After saving the grid, download complete windows appear. CLICK on the ‘open
button’ to start Design-a-Grid.
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Download complete =10l x|

N
(=] Download Complete

Saved:
template.g38 from E:AGRDDASOZAGRIDDAT A,

Downloaded: 128 bytez in 1 zec
Download bo; C:htampattemplate. g38
Tranzfer rate: 128 bytez/Sec

[ Cloze thiz dialog box when download completes

Open | Open Folder | Cloze I

6. When using Design-a-Grid, you must choose the database(s) you wish to use in
creating your grid. The Grid Database Dialog (below) allows you to choose from
among all installed GEODAS Grid Databases. CLICK OK after selecting the
grid database.

F Choose Grid Database(s) to use - | Ellﬂ
Availlable Gnd D atabazes Gnd Databazes ta ze [az ordered]

S Coastal Felef Model 3 5econd &nds

N

<X

¢ Kk, x Cancel | ? Help |

SIS A 5

7. Design-a-Grid in Grid Translator will present a grid parameters dialog. This will
give you the opportunity to enter your own grid limits. Other grid parameters can
be entered or changed for your output grid.
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? Grid Parameters for OUTPUT file

=10 x|

Lat / Lon Bounds [dearees,minutes);

[ 4]0 2]

kirirnLrn

|?5 §,|3u ﬁllw |
EE i
GRID CELL SIZE

I 3 zeconds j

HUMBER OF CELLS [LAT & LOM]

|01 w  |501

|?5 ﬁ"E ﬁllw | [0

GRID RADIUS:

b aximuinn

Precizion:

MHumber Type:

Empty Grid-Cell  alue:

W ater Datum:

|n

10thz af meters

I tenths of meters

I 4-byte integers

[
I 933333

I tean Sea Level

[~

o OK

x Cancel |

? Help [

8. Choose the file options for your output grid. Use the Grid Options Dialog to
determine format, byte swapping, header, delimiter, etc. Choose the ASCII Raster
Format in Output Grid Format option and Arcinfo/ArcView Header.

F‘ Grid Options

=101 |

— Output Gnd Farmat

= Delimited lon lat,depth

" GRD38 Binary Faster Format

™ Mo Header

& Anclnfofdrciiew Header

" Space

i Tab

& Comma

— Integer Bpte Order
¥ Little Endian [PC, HP. etz

™ Big Endian [SUM, Mac, etc.]

— Field Crelimiter

= Al Cells

" SeaCell: Only
= Land Cells Only

W 0K

x Cancel |

? Help |
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9. CLICK OK and use this to name your output file and determine the directory you
wish to save it in. The file will be saved with an .asc extension.

10. Next, open an ArcInfo workstation to generate the grid from the text file you saved.
11. To generate grid use Asciigrid Arcinfo Command.

ASCIIGRID <in_ascii_file> <out_grid> {INT | FLOAT}

Arguments
<in_ascii_file> - the ASCI|I file to be converted full with path.
<out_grid> - the name of the grid to be created.
{INT | FLOAT} - the data type of the output grid.
INT - an integer grid will be created.
FLOAT - a floating-point grid will be created (use floating point)

12. An Asciigrid command will generate an Arcinfo grid with projection in geographic
coordinates. You need to convert the grid projection to one you are using, for running
WEMo. ArcGIS Arcinfo or Arcinfo workstation is required to project the grid to
required projection.

Shoreline

A shoreline dataset is required to clip the fetch with the land. Shoreline datasets should be as
detailed as possible depicting islands and the actual shoreline. Line coverages of the shoreline
can be converted into a polygon using the ArcToolbox. Line coverage should be closed to
make a closed polygon. For e.g. the image below shows the shoreline coverage for Tampa
Bay with enclosing the waterside.

Shoreline Data Mining & Preparation

Shoreline datasets could be found at NOAA website or USGS websites. These sites have
large collection of shoreline datasets for estuaries and bays. The website to extract shoreline
data from

http://www.ngdc.noaa.qgov/maga/shorelines/shorelines.html
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2 NGDC /WDC MGG, Boulder-Shoreline /Coastline Databa =10 x|

File Edit Yiew Faworites Tools  Help |
HBack + = - () ol | ‘Qhsearch [ElFavorites flfMedia (4 | S = =
Shoreline / Coastline Data B

G5HHS - A Globhal Self-consistent, Hierarchical, High-resolution Shoreline Database

HOAA's Medium Resolution Digital Vector Shoreline Database

-
4| | b

&) I_ I_ I_ |4 Internet 4

Steps for extracting and generating shoreline polygon coverage
1. CLICK Coastline Extractor on the above mentioned website to launch the

program. Use numerical geographic range to describe the area you are interested
in or you can use the java map to select the range.
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Pleasze do not try to extract huge regions like all of the TS coasthine frotn "WW3, there iz a
00,000 point limit on each extraction. Thanks! If veu select a range that covers mote that a
few degrees, be prepared to wait while the data are extracted and (optionally) the coastline
image 12 created.

Coastline data hase: |NOANNOS bedium Resclution Coastling (designed for 1:70,000) j

Compression method for extracted ASCIT data:
& Mone € GMNU GZIP ¢ UND{ Compressed ¢ ZIP

(“oast Format options:
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Coast Preview options:
© Mo preview & GMT Plot

Extract the Coast: SUBMIT - Extract the Coastline File |
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N | K

2. Select NOAA/NOS medium resolution coastline for Coastline database. The
resolution is 1:70,000. Select Compression method for extracted ASCII data as
none and Coast Format options as Arclinfo Ungenerate format.

CLICK ‘SUBMIT —Extract the Coastline File’ button.

3. The coastline file will be generated along with a map depicting the area, please
check the range before downloading the file. Save the file on your hard disk. Two
options are available to convert Arcinfo ungenerate file into Arcinfo coverage.
The selected data returned by the query is an ASCII flat file with two columns
containing longitude and latitude in decimal degrees (west negative for North
America). ArcView will not read the Ungenerate format directly, but you can
convert from Ungenerate to a Shape file that ArcView can read using the script
gen2shapl.ave. Paste the script in ArcView script window, compile it and then
run the script. The script will ask for the downloaded file. Avenue script is also
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available in Appendix B. Yet another method is to use the Arcinfo generate
method, converting it into ArcInfo line coverage as shown below.

i Arc¥iew GIS 3.3 =10 x|
Eile  Edit iew Theme Suface Graphice Window Help

(@ x o [al@lC] ] 7 =]« TS] s 1705335 E i b

ﬂ Tampa Line coverage 2|

4. Line coverage generated by either ArcView or Arcinfo has to be converted into
polygon coverage. Line coverage should be closed to make a closed polygon. To
close the polygon, start editing the theme. Choose the tool Draw Line to Split

Feature and draw line to close polygon. Create a boundary on the waterside
of the coverage similar to that shown in the figure below. Make sure to create the
boundary as big so that the distance between the selected sites and the boundary is
greater than the maximum selected fetch length.

Editing of coverage could be also be done using ArcGIS or Arcinfo workstation.
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5. After closing the line coverage it can be easily converted to polygon coverage using
ArcGIS ArcCatalog. (Note: This step requires either Arcinfo or ArcEditor license for
ArcGIS) Navigate to the shapefile in ArcCatalog and right CLICK on the shapefile.
From the menu select export -> shapefile to coverage. Save the Arcinfo coverage to
your hard disk.

6. Right CLICK on the coverage saved above and CLICK properties. A window will
pop up as shown below. CLICK on the clean button to create the topology for the
polygon coverage. The clean window will pop up. Use the default settings and
CLICK OK. CLICKing Ok will generate polygon coverage with the desired
topology.

Note: If you don’t see proper polygon coverage, you might have gaps in your closed
polygon. Try using a higher number in the ‘Clean’ window for fuzzy tolerance. If it
still doesn’t generate polygon coverage closely check your polygon in line coverage
for gaps.
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Coverage Properties

General | Projection | Tics and E:-ttentl Tolerances
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Cancel |

Apply |

7. Polygon coverage as shown below should be generated. You have successfully
generated the shoreline coverage.
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Note: Export format files are converted to Arcinfo format using Arcinfo workstation or
ArcView 9.1 toolbox ‘Import to coverage’ option.
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Appendix A (REI Mode)

This section provides explanation regarding the powers assigned to the Inverse

Distance Weighting (IDW) function in greater detail and will focus on the numerical and
other technical features.
WEMo assumes wave energy generated at a site depends on the fetch, water depth and the
wind speed. The IDW function calculates the mitigating effect of fetch and depth on the REI
as the fetch increases and depth changes in proximity to the calculated point. The rate at
which REI changes depends on the power of the IDW function.

The Army Corp of Engineers Shore Protection Manual (SPM) was used as a
reference to obtain powers of the IDW function. The SPM includes wave height Vs Fetch
graphs which were used for the verification purposes. Given that wave energy is directly
related directly to wave height, wave height graphs were plotted against the fetch as shown in
figure below.

The graphs were plotted for two depths; 5 ft and 10 ft as these depths fall near much
of the work where estuarine studies occur. An assumption of constant depth was made for the
wave generation calculations. Both graphs show various plots for different wind speeds in
miles per hour. Wind speed affects the wave height generation along with the fetch. The
higher the wind speed more the wave height for a given fetch as depicted in the graph.

Wave height at 5ft Depth
3
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. 25WSpd
T 2 30WSpd
= | —%—40WSpd
T1.5 - ‘ —e—50WSpd
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0.5 ‘/_/‘7 80WSpd
— 100WSpd
0 - ‘ ‘ ‘ ‘
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Wave height (ft) Vs. Wave fetch (m) at varying wind speeds (mph) and constant depth of 5 m.
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Wave Height at 10ft Depth
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Wave height (ft) Vs. Wave fetch (m) at varying wind speeds (mph) and constant depth of 10 m.

Graphs were normalized for wave height to project it on the same scale as the IDW power
function graphs. The normalization is done using the maximum wave height attained by a
wave for a particular wind speed and depth. For example, maximum height attained by a
wave at 60 mph and a water depth of 5 ft is 2 ft, so all wave heights were normalized by 2 ft.
The next two graphs show normalized wave height graphs for 5 ft and 10 ft water depths.

49



Normalized wave ht at 5 ft Depth
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After normalization of the curves, a power function was assigned to each curve for each
depth. The power functions for all the wind speeds are shown in the table below for each of

the depths.

mph 10ft 5ft
15 y= 0.0154x°%37%7 y= 0.0277x03448
20 y = 0.0156)(0'3906 y - 0.036)(0.3209
25 y= 0.0168)(0'4016 y = 0-0348X0'3477
30 y = 0.0205x"%* y = 0.0393x°:34%
40 | y=0.0283x"** y = 0.0516x°%7
50 | y=0.0347x°3° y = 0.0673x°%%
60 y= 0.0478x°-314 y = 0.1361x%-2084
70 y= 0-0643X0'2809 y = 0-1036XO'2586
80 | y=0.0597x*%%° | y=0.0978x"%%%
100 y= 0.0689x°29% y = 0.1434x°%-23%1

Power function for wind speeds at 5 m and 10 m depths.

To make the final wave generation function, wind speed was divided into 3 categories and
each category was assigned a power function derived by averaging the powers from that
category from the above table.

Three categories are for 5 ft depth

0-30mph 0.33

30+ -60 mph 0.30

> 60+ mph  0.25

Three categories are for 10 ft depth

0-30mph 0.39

30+ -60 mph 0.35

> 60+ mph  0.29

To implement these results in the IDW function, a decay curve for the IDW function was
plotted from the equation:

IDW = 1/(distance + 1) > (1 — distance / fetch)

51



Where distance is the cumulative distance from the site, fetch is the maximum wave fetch
selected in WEMo options and z is the power to be derived. The decay curve was converted
into a cumulative curve to emulate the SPM curves derived above.

The power z was then derived for each of the wind category

0-30mph 0.053

30+ - 60 mph 0.062

> 60+ mph  0.082

These are the recommended power functions for three assigned categories, used to calculate

REI in WEMo. The graph below shows the cumulative IDW function for three categories.
The next graph shows the IDW function for three wind speed categories.

Cumulative inverse distance weighting for three wind

1 speed categories
\
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Inverse distance weighting for three wind speed categories
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IDW function for three wind speed categories

After assigning a power function for each wind category, each ray generated from the site in
the 8 compass heading directions will have a power for use in the IDW function. However,
the 4 rays radiating out from either side of the i" compass heading at increments of 11.25
degrees, will not have any associated wind speed, hence they do not have a power value to
utilize in the IDW function. To assign a power for intermediate rays, a linearized average
function was used between adjacent i"" compass headings to calculate intermediate powers.

For example, if easting has power of 0.082 and northing has power of 0.062 then,

1% intermediate rays power —> 0.082 + (0.062 — 0.082)/4 = 0.077
2" intermediate rays power —> 0.082 + 2*(0.062 — 0.082)/4 = 0.072
3" intermediate rays power —> 0.082 + 3*(0.062 — 0.082)/4 = 0.067

There is an option to change these power functions as well as wind categories in WEMo as
explained elsewhere in the manual. However, increasing the number of categories increases
the processing time while significantly decreasing a function causes coarse results. It is
recommended that without specific cause for selecting other options that the user adopts the
default values described above.
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Appendix B

This ArcView 3.2 avenue scripts convert an ungenerate format vector file downloaded
from NGDC website into ArcView shapefile format. Please copy and paste it in the
ArcView script window and compile it before running.

Script obtained from NGDC website.
Script Starts

' Generate2Shape
" Originally based on GPS2Shape by GAT, GEODATA AS
" Converts a file with ARC/INFO Generate format to a AV2 Shape file

"Ver. 1 by GAT, GEODATA AS Dec, 28 1994

" ARC/INFO Generate format for lines implemented
' Format:

"ID

"Xy

"Xy
"END
"1D
"Xy
"Xy
"END

"END
" Choose the Generate file to convert to shapefile...

genName = FileDialog.Show("*.*","Generate File","Select Generate File to Convert™)
if (genName = nil) then

exit
end

genFile = LineFile.Make(genName, #FILE_PERM_READ)
totalRecs = genFile.GetSize

' Specify the output shapefile...

defaultName = FN.Make("$HOME").MakeTmp("shape”,"shp™)
shpName = FileDialog.Put( defaultName,"*.shp","Output Shape File")
if (shpName = nil) then

exit
end
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shpName.SetExtension("shp")

" Specify which kind of shapefile to create and make the new FTab...
"In current version (1.0) only line

type = MsgBox.ChoiceAsString({"Line"},
"Convert coordinates to:", "Generate Convert" )
if (type = Nil) then
exit
end

if (type = "Point") then
shpFTab = Ftab.MakeNew(shpName,Point)
elseif (type = "Line™) then

shpFTab = FTab.MakeNew(shpName, Polyline)
elseif (type = "Polygon™) then

shpFTab = FTab.MakeNew(shpName, Polygon)
end

fields = List.Make

fields.Add(Field.Make("ID", #FIELD_LONG, 4, 0))
shpFTab.AddFields(fields)

shpField = shpFTab.FindField("Shape™)

idField = shpFTab.FindField("1D")

genRec =0

av.ShowStopButton
av.ShowMsg("Converting"++genName.GetBaseName+"...")

" If the user has chosen 'Point’ then the FTab is written here in the
"while loop. Otherwise if 'Line' or 'Polygon’ has been chosen we
" collect coordinates in the loop for writing to the FTab later...

while (true)
buf = genFile.ReadElt
if (buf = Nil) then
break
end
if (buf = "END") then

break
end
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if ((type = "Line") or (type = "Polygon™)) then
pointList = List.Make
thelD = buf
buf = genFile.ReadEIt

end

while (true)
genTokens = buf.AsTokens(",")

if (type = "Point") then "write points to FTab...
thelD = genTokens.Get(0)
thePoint = genTokens.Get(1).AsNumber@genTokens.Get(2).AsNumber
rec = shpFTab.AddRecord
shpFTab.SetValueNumber( idField, rec, thelD.AsNumber )
shpFTab.SetValue( shpField, rec, thePoint )

elseif (type = "Line") then ' collect points defining line...
thePoint = genTokens.Get(0).AsNumber@genTokens.Get(1).AsNumber
pointList.Add( thePoint )

elseif (type = "Polygon") then ' collect points defining polygon...
thePoint = genTokens.Get(1).AsNumber@genTokens.Get(2).AsNumber
pointList.Add( thePoint )

end

genRec = genRec + 1
progress = (genRec / totalRecs) * 100
proceed = av.SetStatus( progress )
if (proceed.Not) then
av.ClearStatus
av.ShowMsg( "Stopped" )
exit
end

buf = genFile.ReadEIt

if (buf = Nil) then
break

end

if (buf = "END") then
break

end

end

"If Line or Polygon we still need to create FTab...
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if (type = "Line") then
rec = shpFTab.AddRecord
shpFTab.SetValueNumber( idField, rec, thelD.AsNumber)
pl = Polyline.Make( {pointList} )
shpFTab.SetValue( shpField, rec, pl)

elseif (type = "Polygon™) then
rec = shpFTab.AddRecord
shpFTab.SetValueNumber( idField, rec, 1)

" Add first point to end of list to close the polygon...
startPoint = pointList.Get(0)
pointList.Add( startPoint )

pl = Polygon.Make( {pointList} )
shpFTab.SetValue( shpField, rec, pl )
end
end
av.ClearStatus
av.ClearMsg
shpFTab.Flush
MsgBox.Info( genRec.AsString++"records converted.” ,"Conversion Completed™ )

Scripts End
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Appendix C
Step-by-step guide on creating a point-grid of values using ArcGIS

Sometimes exposure values are desired for a larger whole area of interest in a grid format
as opposed to few selected sites. Output from such a process provides the data needed to
generate a surface response (e.g., krigged) for a pleasing graphic (this is beyond the scope
of this help document). Creation of a grid dataset can be accomplished by creating a
point grid using ArcGIS tools. This appendix explains in a step-by-step fashion how to
create the regular grid with desired resolution.

ArcGIS model
To simplify the steps in creating a grid, we created an ArcGIS model that can be loaded
in the toolbox to automate all the steps except creating the polygon shapefile (see below).

A more detailed description of the process is given after this section.

This model is provided in the WEMo installation and should be available in folder ‘Help’
under WEMo installation folder.

A schematic of the model is shown below:

Fl
Shoreline dataset
P
P P
(‘ Clip Point_grid.
Feature to shp
Polygon shapefile Raster

-

Temp_raster R?:’S;?r:tm
To load the model in ArcGIS, right click inside the open area in ArcToolbox window and
select ‘Add Toolbox’ navigate to the Help folder where ‘Point Grid.tbx’ toolbox is saved.
This will add the Point Grid toolbox in the list of toolboxes in ArcToolbox window.
Double click the “Point grid tool” tool and this will open up the parameter window shown
below.

Output point grid
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‘—}"J Point grid tool E]@

Q Polygon_Shapefile

] Polygon_Shapefile _‘j
Q Shoreline_dataset

|Shore|ine_dataset
Q Paint_grid.shp

JE:\lemp\F‘oint_grid.shp

Cutput cell size {optional)

{500

oK | Cancel Errdronments. .. Show Help »»

To run the model, select the polygon shapefile you created, shoreline dataset, desired
resolution and the name of the output point grid. After clicking OK the model will run all
the steps described below and generate the point grid shapefile.

A more detailed step-by-step version of the model is given below, INCLUDING
HOW TO CREATE THE POLYGON in the first place.

e To start we require a shoreline dataset of the area of interest, either in shapefile or

Arcinfo coverage format. This can be obtained as explained in “Data

requirement” section of the manual.

The figure below shows the shoreline dataset we will use here as an example.
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CREATION OF THE EMPTY POLYGON SHAPEFILE NEEDED TO RUN THE
MODEL, ABOVE

e After loading the shoreline file in ArcGIS create an empty polygon shapefile

using ArcCatalog. Open ArcCatalog either from ArcMap window or from the
Start-> ArcGIS - ArcCatalog.

e In ArcCatalog window navigate to the desired folder and right click to select
New-> Shapefile.

e In the Create New Shapefile window make sure to select ‘Feature Type’ as
‘Polygon’ and select the name of the shapefile shown in figure below.
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+-(_] ArcGls Download = Export_Oukput_2.shp Shapefile
+-(_]] Bass ‘ [ feature_new_L Raster Dataset
+-{_] Boat ‘wake ] reature_new_z Raster Dataset
+ |;| Burke Alaska [ feature_new_3 Raster Dataset
4 |_—1 Contracts ‘ [ feature_new_4 Raster Dataset
4 L——l coral model & arid_stpl Raster Dataset
* l,—-l dell @ aridnc Raster Dataset
#1-( Docurenits and Setting | | (2] e 1953 1008 tat Text File Copy  Chrc
= l_——l Don stuff @ nicgrid_stpl Raster Dataset = = ‘
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+.(27 Flaridakeys1 Mew_Shapefile.shp Shapefile Rename Fz
.3 s Paint_grid.shp Shapefile C Eakinid
+-(20 GPS Programs (= Point_grid1.shp Shapefile e
+. ] aPs PR [ paint_aridz shp Shapefile By P Eolder
+- (20 grids_shaorelines B rastert_featurel.shp Shapefile 9‘ T ) a Pereonal Catdatabase
+ [ 386 B rastert_feature2.shp Shapefile st =
+-(C] Jud_work [ rastert_featured.shp Shapefile Froperties... <> Layer...
+ |:_'| Library @rastert_featureS_CIip.shp shapefile B —— @ Group Laver
+-_1 mail astert_featured,shp Shapefile —
+-_] Marsh Study rastert_feature4_Clip,shp Shapefile
+-] MissionZ005 [ RasterT_xy11_Clip.shp Shapefile B
* |_J M50Cache @RasterT}ylZ?Clip.shp Shapefile
+ lr—l NW.S_Isabel BBRasterT_xyl_Clip.shp Shapefie a daclbe
21- Optical Model tin TIN Datasst dBASE Table
: + |__'| Pats Mode| @tin.lyr Laver
S, il | FPing TIN Dataset -]

rreatac A new chansfils

Create Mew Shapefile

M arne: |F'-::Iygon_shapefile|

Feature Type: | Polygon ﬂ

Spatial Reference

Description:

Unknown Coordinate System

I Show Detailz Edit...

I Coordinates will contain M walues. Used to store route data.
I Coordinates will contain 2 values. Used to store 30 data,

Ok, I Cancel
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e Add this empty shapefile in ArcMap to edit. Edit the polygon shapefile to create a
new polygon approximating the area of interest using the editor toolbar ‘Sketch
Tool’ in ArcGIS (usually the pencil icon). The figure below shows the new
polygon approximating the area of interest. Save the edited shapefile once you are
done creating the polygon.

i

(Now ArcGIS geoprocessing model presented above, can be used for grid generation)
e The polygon shapefile must now be converted to a grid using ArcGIS tools. Open
ArcToolbox and navigate to the tool ‘Feature to Raster’ being sure to select the
grid resolution that you wish to have WEMo’s values computed.

Conversion Tools = To Raster = Feature to Raster
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Input features

|g Mame of the palygon shapefile j ﬁi
Field

fid =l
Output raster

Il:: wtemphFeature Mew 4 ﬁi

Q Output cell size {optional)
Idesired regolution [e.g. 500 mts) Dq'l

Ok I Cancel Enviranments... Show Help >3

The previous figure shows the ‘Feature to Raster’ tool. The ‘Field” parameter
should always be set on ‘Id’. A raster grid is then created as shown in the figure
below.
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e In the next step this grid is converted into a point shapefile, where each point is
created at the center of the grid cell. To create the point shapefile use the tool

‘Raster to Point’

Conversion Tools = From Raster = Raster to Point

#* Raster to Point g@
Input raster
]0 name of ofid file created in last step j
Field (optional)
1Value _v_J
Cutput point features
]E: temphR asterT_featured. shp

ak | Cancel Environments.... Show Help »>

e This tool creates the point dataset covering the area of polygon shapefile with the
desired resolution. The example below shows the point grid at 500 meter
resolution (as selected previously).

Note: Remember that every doubling of the resolution of the point grid increases the
computational time four-fold. In most of the cases 500 meters is a desired resolution.
Where bathymetry is uneven and shoreline is complex, higher resolution grids should be
used though only for small areas.
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e In the next step the grid points lying on the land are removed using the clip tool in
ArcToolbox. The clip tool can be accessed as

Analysis Tools = Extract = Clip

7 et SE]
Input Features
]0 Paint arid dataset | _:_]
8 Clip Features
] Shoreline dataset L]
Output Feature Class
;E “tempirastert_featured_Clip.shp

Cluster Tolerance {optional)
JUnknown _1]

ok | Cancel Environments.... Show Help >3

Clipping removes all the points from the land and leaves a point grid solely for
the water-covered area.
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The created point grid is an ArcGIS shapefile and is ready to be processed in WEMo
successively. (Refer to ‘Adding point datasets’ section ‘Using external point dataset
method”).
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Contact Information
Model Designed by:

Mark S. Fonseca Ph.D.

Leader, Applied Ecology and Restoration Research Branch
NOAA, National Ocean Service

National Centers for Coastal Ocean Science
Center for Coastal Fisheries and Habitat Research
101 Pivers Island Rd

Beaufort, NC 28516-9722

(252) 728 8729 office
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